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1 Netop Live Guide

The Netop Live Guide Operator Console is your interface to manage contacts from

customers who click a button on your company Web site because they wantto  getin
touch with a company representative for information or  for assistance.
Each customer contact session is logged , for example with information about chat

duration, campaign and department, to enable you to subsequently do statistics
based on the historical data.

The information displayed in the ¢ ustomer calls list can be customized as can the use
of colors and the use of audio for various types of alerts.

The three main sections below describe how to manage chat s, how to use historical
data and how to customize the Operator Console interface to ma tch your
preferences. The first section, though, briefly describes the logon procedure.

2 Log on to Netop Live Guide Operator Console

For your initial log on to Netop Live Guide Operator Console , you will receivea n email
with alink to the ~ Operator Console as well as a password to be used for your first
logon.

When you click the link you are
presented with a launch screen and
then a logon screen where you must Language | Englich o)
type your email address and the
password from the  email .

When you have logged on to the
Operator Console , y ou should change
your password.

Email | ajs@webappssolutions.com

Password rules: [¥] Remember
1 The password cannot be the same :
as your email. ==
1 The password must be at least 6 version: 5.0 Flash: 5.0.3.9

characters long.
I The password must include at least
one upper case letter and one digit.

You are automatically asked to change your password  when you log on for the first
time.
See section 5.1 for information about changing password, other than on firs t logon.



3 Manage chat s

When you are logged on and ready to received customer calls you see a window like

this:
Operator's menus to contral
audio andvideo
(N ——————
(2/2] rators (2] All (37
[ customer < — [ Queue | AllCustomers(1) | Departments(2/2) | Operaters(2) | ANG! () siomers and operators

x
Duration 00:24 Location Ballerup, Kobenhav... @ Type Status Proactive Campaign Depa currently online urrent pa...
ey

[11:34:20] == Trying to connect to customer C28 == Customer Talking-Am... Ho Sales and .. | Sales ¥ https:/ith.n...
[11:34:20] =: Trying to connect to customer C28

[11:34:21] :: You are now successfully connected to customer
€28 ::

Chat area

Operator's tools

—

Canned messages | Knowledgebase  Links | Pushpage | Forms

[jArrange meeting?

| Preduct presentation

B I u &3 Take next Reply next

Send

I chotroom c2s

Incoming chat s that have not yet been answered are listed on the Queue tab; the
first chat in the list (from the top) is the customer who has been in queue the
longest.

If customers are asked to fill in a form when they click the chat button, you can see
the information provided by resting the pointer on the customer line

To answer the chat from the customer who has been in the queue the longest, click
the Take next button , or you can double -click a customer information line in the
queue list . You can now begin chatting with the customer in the chat area.

The chat area also display s overvie w information about the customer, for example
the customerds |l ocation. To see more custdaier infor
the top of the chat area.

During the chat, you can choose to turn on
your audio and your video from the

Operator ~ menu. Opanter o || Comemer -

Location Ballerup, K

. Mute my audic
And you can choose whether you want this Start my video )
‘Current page title:

to be for the current customer only or st g o vo p I Code buider i
whether audio or vid  eo should be for all Show s videc s b + Cumnt customer oy
customers.

! This feature is not available in Netop Live Guide Basic edition .



When you turn on audio and video for the first time a Adobe Flash Flayer Seftings

dialog box may ask you if you want to allow Live Guide to Cemera snd Microphane Acssss @
. liveguide01eu.netop.com is requesting
use camera and m|Cr0ph0ne access to your camera and microphone.

If you clicgk Allow, you may be recorded.

B © Ao |[8 ey

This is an Adobe Flash Player privacy setting that shows because Live Guide needs to
take control of the camera and microphone on your computer; click Allow to start
using camera and microphone 2.

From the Customer menu you can choose to
let the customer use his or her audio and
video.

Netop

| operator v | | customer ¥ |

Duration 0g:3¢ ¥ Audio enabled E

v Video enabled
nt

Chat history i
Transfer customer

D ng

‘ bu
Ban IP

Ban Customer /]

A number of tools are available to assist you during the chat; the tools are available
from separate tabs on the Tools tab.

3.1 Queue
The Queue list is the area where customer chat s come in and remain until you or
one of the other operators answers them:
Queue (2) All ¢ (2) Dep. () op () All (11)
Name Status Proactive Campaign Departments New Page title URL
c4zE4 Queus Yes First campaign Sales Tes Cart http:/fnetop.com
4235 Queus Second carmpaign Sales Cart http:/f netop, com
The All Customers list displays all customers who are currently either chatting with
an operator or waiting for their chat to be picked up.
The Queue list, the All Customers list, and the All list have the same types of
information:
Type This can be fACust omethednfomatiomi O e r

particularly useful in the All list where both customers and
operators are listed.

Status What the customer is currently doing, for e X a mp Qeeuef®
or ATal kingbo.

Proactive Whether the customer has automatically been invited to
chat with an operator.

2 | earn more about the Adobe Flash Player settings on www.adobe.com _ or directly from this page
http://www.macromedia.com/support/documentation/en/flashplayer/help/settings_manager02.html


http://www.adobe.com/

Campaign The campaign that the customer called from.

Department The department that is being contacted or that has
answered to chat.

New Whet her this customer is a firs:
AiNoo.

Page title The title of the Web page that the chat came from.

URL The address of the Web page that the chat came from.

The Departments list displays the departments where operators are currently

logged in  while the Operators list display the names of the operators that are
currently logged in. The two lists basically have the same information but present the
information from different po ints of view.

The final list, the  All list, displays all currently active users, both operators and
customers. The types of information are the same as in the Queue andthe All
Customers lists.

Note You can customize the information you see in the queue. See section 5.4
for information about changing the queue

3.2 Chat area

When you click a customer information line in the queue list, you answer the chat
and can beg in chatting with the customer in the chat area:

Netdp You type your message in the message area and
T E— P view the chat conversation T both your messages
= rraen | and the cust omeintheschataeep.l i es

comeaeTs Depending on your edition and on your setup, you

may be abletos ee what the customer is typing
before the customer has act  ually sent his
message °.

Use the formatting buttons under the chat area to
format your text.

Depending on the way your system administrator
has configured your interface , a number of tools
like for example predefined text and predefined

links are available to make your chat conversation
easier. See section 3.3 for more details.

If you want to use audio and video instead of text

S chat, you canturn  on your microphone and your
essagearea J camera from the Operator menu . See section 3 for
’ more details.

You can chat with  several customers at a time
e usingthe C1, C2, C3 etc. tabs to switch between
them.

3 This featureis not available in Netop Live Guide Basic edition .



If a customer asksa  question that you do not readily know the answer to, you can
switchto Chat room and ask your colleagues for information. Chatroom isa chat
area that is common to all operators and visible to operators only.

If one of your colleagues is better able to assist the customer, you can transfer the
chat by clicking Customer andthen Transferc ustomer

In case a customer is offensive or ot herwise behaves inappropriately, you can

prevent the customer from being accepted on the Queue list again by clicking

Customer andthen BanlIP or Ban Computer . The latter option places a cookie on

the customerds computer that idestiheesompuwlkeedsas o

address. You can review banned users and remove bans from  Settings . See section
5.5 for more details.

Click Customer andthen Audio Enabled or Video Enabled to allow the customer
to use one or the other . This could for example be  useful to temporarily enable sound
i maybe to allow the customer to better elaborate on an issue - in a campaign that
otherwise has been designed to use chat only .

The chat area includes summary customer information with IP address, geographical
location and chat duration ; ifyou need detailed customer information you can switch
tothe Customeri nformation tab. See section 3.5 for more details.

3.3 Tools
Tools Customer Information The Tools tab includes
various aids that can make
Canned Messages Knowledge Base Links Push page Forms

your customer communication

» [ ] Technical easler.

P[] Seneral

|| How to build a cart

The actual content s of each category on the Tools tab vary since it depend s on the
system administrator 6 s s dut thgse are the main categories:

Canned Messages These are texts that you use very requently so to save you the
work of typing the same text repeatedly, the text has been
given a name and defined as a standard text. T 0 use it you
select the name of the text from a list and it is automatically
written in the text chat to the customer.

Example:

A relevant text for any operator, regardless of department could
for example be:

Al ol l have to | ook up tdase haddomafort i

second. O

The text might be naaradowiitethestexttoe w
a customer, you would select the name Please wait  from a
list.

The system administrator can define as many texts as are
needed and the texts can be grouped so that yo u can choose to
see texts that are relevant to your area only.



Knowledge Base

Links

Push page

These a basically the same a s canned message only knowledge
base texts are longer, procedural type texts.

Exampl e:

A relevant knowledge base text for an operator in a support
department could for example be:

ATo request a new feature, please

1. Download a feature request form from our Web site.
2. Fill'in the form.
3. Send the form to us in an email .

We will get back to you  with a response within one work week.

The text might be named: fiFeature
entire message to a chat customer, you would select the name
Feature request from a list.

Like canned messages, the system administrator can define as
many texts as are needed and the texts can be grouped so that
you can choose to see texts that are relevant to your area only.

These are links to Internet sites that you frequently refer

customers to. The links work like the predefined texts: the
system administrator define s names and links and you select a
name to have the entire address automatically added to the

chat area.

These are links that you can push to the customer to control
what he or she sees on the scr een: a new window opens in
front of the Website with the chat button and because Live
Guide is on top of the browser, you can take control and
redirect the user to a new URL.



Forms These are forms that you can ask the customer to fill in to

collect information  in a structured way. For example, if you
Note: Forms are

) - belong to support department , the information could be about
not available in the date of purchase, the name of the reseller, the serial
Netop Live Guide number, and ad escription of the error situation. Or for
Basic edition . customer asking for a trial download, you might want to col lect

some information before pro viding the download link.
To push a form to the user:

1. Onthe Forms tab, double -click the name of the form you
want to push.

oot [

Canned messages | Knowledge base | Links | Pushpage | Forms

I_] Free trial

The form is now listed in your chat area by its internal
name, for example A/form 30.

2. Inthe chat area, click the Send button to push the form.

=] % | Takenext || Replymext

fform 10304 Send

Though you see the 1G3®rom dshifs/ fisr m
form might look like to the customer:

2 Netop Live Guide - .. | =

' ? https: T a 2\

|
)]

Back to chat Close form

Firstname (*)
Lastname (*)
Telephone (*)
Countr/Region (*)

Denmark b
What s your reason for downloading
*)

— Please select — X

{¥) - Mandatory

®100% ~




Depending on the campaign 08-04-2011 13:56:10

settings that your system Amanda(14:00:09): /form 10304

administrator has defined, the

cus t omer o S I n put [13:59:57] :: Trying to connect to customer CO ::
toyouinand email or directly [13:59:57] :: Trying to connect to customer CO ::

to the chatareaa s p|ain text, [13:59:58] :: You are now successfully connected to customer
for example: oo

[14:00:04] :: Sending form Free trial ::
[14:02:43] CO: First name: Peter

Last name: Johnson

Telephone: 12345678

Country/Region: United Kingdom

What is vour reason for downloading: Use free trial

3.4 Operator status

When logged on you default status is Available butyoucan setitto Busy ifyou are
temporarily unable to take customer chats:

Availzble

Operator v | [ Customer ¥ ¢ (/1 op @

Duration 48:53 Location Ballerup, Kobenhav... Proactive | Campaign Department  New Currentpa... Current pa...

When your status is  Busy , you will not count as a resource when customer waiting
time is calculated.

Note that if all operators set their status to Busy the chat button wil | automatically
have status offline.

3.5 View detailed customer information
If you need more details than is available in the summary customer information in

the chat area, you can find additional information on the Customer Information
tab:
Customer Details Chat History Notes Categories
B 89.35.54.249
Time on site 43 seconds
I City Chicago
i Region Illinois
i Country United States
isp Qwest Communications
Domain netop.com
Organization Netop
| Landing Page Title Netop: Secure remote control, cla: &
Landing Page URL http:/ /www.netop.com/
Current Page Title Netop Live Guide: Rich Media Chat - Video, Voice, and Text
| Current Page URL http:/ /www.netop.com/live-guide.htm
Keywords rich media chat
Proactive Chat No
Operating System Windows 7
Browser Type Mozilla Firefox
Browser Version 3.6.6
Customer Details Customer details include many types of information, among

them information about previous chat s, the operator who
handled the last chat, the campain the customer called on, and

the customerés domain and organi z

The detailed customer information can be used for a number of
purposes, for example to trace customers that you would like to
followup onorto  be able to provide better assistance based on
your increased background knowledge.

Keywords include information about how the customer landed
on the page withthe chat button, for example through



keywords from a search engine like Google

The information can be exported and also sent to an email
address. This can be useful for subsequent follow -up on the
customer , for example a reminder to contact the customer
later.

Chat History The Chat h istory tab shows all previous contacts with the

customer , including any notes you or another operator may
have made as well as the reason the customer called
(Category ).

The information can be exported and also sent to an email
address . Like for the customer details described above, this can
be useful for subsequent follow -up on the customer.

Notes Notes that you or another operator made for previous chat s as

well as ate xt edit area that allows you to make notes to the
current chat.

The information can be exported and also sent to an email
address as an indication that follow -up on the customer is
needed.

Categories Categories are used to indicat e the topic of a customer chat and
can later be used to generate statistics. For example, for
operators from the support department, categor ies could be

product names ; for operators from a sales department , the
category could also be product na
flexi sauantgomermigp,ot ent i al customer 0.

The system administrator may set up the system so that it is
mandatory to select a category before a chat can be properly
ended. If this is that case, you must select one of the

categories from the list before your status changes to available.

4 Use logged data

In your everyday work you will typically use the tools and features described in the

section above. However, occasionally you may need to review past customer chat s or
generate chat reports. To do this you can clickthe History button and switch from
real -time view to historical view:

Nejt')p | Available v || Calls | History | Settings | | Logout |

In the history module you can view logged data, use filter criteria and export to a file
orsendtoan email recipient.

4.1 Use filters to get the report you need

When you click the History button, information about all chat s re corded by the
system is displayed in a list format. You can browse through the list and for the
current conversation see the chat log and any notes made by the operator.

Typically though you will likely want to filter the information to limit the data you see.
You can do this by filtering on:

1 A specific session.

1 Sessions within a date  range .

1 Sessions handled by a specific department.
1 Sessions from a specific category.



1 Sessions that include specific key words
The filter criteria can also be used in combination.

Select the filter criteria you want to use in the Range section and click Filter to
apply them to the list:

4.2 Export report data

When you have generated a filtered report, you can export it to an external file for
further processing.

1 Clickthe Exportas button to select a file format, and then click the Export
button.

Export as ...

Tesxt File

Czw File (Excel)

If you selected Csv File (Excel) , the file opens in Microsoft Office Excel and it you
selected Text File it opensin Notepad. From either of these programs, you can then
choose to save the file locally.

4.3 Send logged data to an email recipient
Instead of exporting to a file, you can also choose to send the report to an email
recipient .

1 Type the recipients email address and click Send .

N -]

The reported data is pasted as t extintothe email .

5 Customize how Live Guide Operator Console works

You can customize how Live Guide Operator Console  works within these areas:

Your profile .

When you receive alerts.

Layout of the chat area and the queue.

Fields and colors inthe  queue and fields in the video area
Font size and text color in the chat window and in the queue.
Restrict customer access.

E R EE EE]

Any changes to how the  Operator Console work is done by click ing the Settings
button:

5.1 Changeyour profile

When you first log on to Live Guide Operator Console ,youdosowitha n email anda
password and you will t ypically be requested to change your password on your first
logon.

10



If you later want to change your password, you

can do so fromthe My profile

Display Name

tab.

is the name that the customer

sees in a chat conversation. You can also

change this here.

Depending on your edition
settings under My profile

Preview
|¥] Preview of customer messages
|v] Preview of pre-chat form

Save

Dictionary

Save

|¥] use dictionary during chat | English -

My Profile | Alerts

Update account information

Display name is your name as customers see it when you are chatting

Uss ths password fislds to changs the passwerd you uss whan you log

Display name Amanda

0ld password

New password

Confirm password

Save

4 and on your system setup you may have additional

To increase your overview of customers in the queus you can choose to see the information each customer has supplied in a pre-chat form.

To reduce your response time and make chat flow mora like a convarsation you can choose to see what tha customer is typing before he or she has actually sent the massage.

Preview of customer message

This option enables you to see
what the customer is typing while
he or she is typing. This can
potentially reduce your response
time and make the chat flow
more like a natural conversation.

The text is shown in a special
area and moved to the actual
chat area once the customer
sends the message:

* This feature is not available in Netop Live Guide

e o || e ()

Duration 00:26 Location  Birkerad, Hovedstad...

[16:08:52] :: Trying to connect to customer C1 &
[16:08:52] =: You are now successfully connected to customer C1 ::

I
I would like additi

TE T T ] 0 & & | lakened REply next
Send

—— e o

Basic edition .

11




PreV|eW Of pre 'Chat forms Queue (1) All Customers (1)  Departments (2/1)  Operators (1) Al (2)

Name Type Status Campaign Department Number of pr... | Proactive Current page ...

This option enables you to see a @ e
preview of the information : e
customers have typed in the form
they fill in before their chat
request is listed in the queue.

0 No. Code builder - L.,

a
with an educational

in: on?:
What is your reason for downloading today?: 30-
day trial

Previewing this information enables you to decide whether you or one of your
colleagues is the better equipped to respond to the chat request.

Use dictionary during chat This option enables you to choose whether you
want Live Guide to check spelling and grammar
as you type messages to customers.

5.2 Change settings for how you want to be alerted

You can use the Alerts tab to define whether you want to be alerted with a sound,
by a text change in the title of the current page, or by a combination of the two.

([ Wew messnge From customer I~ 1 Select an event in the list, then select how to
T be alerted, and click ~ Save .

New message in support room

Hew customer in the queus
New operator joined the chatroom
Customer turned on audio
Customer turned on video

Customer was transfered

5.3 Change the layout of the chat area and the queue

By default the  Operator Console reserves a large part
of the available screen real estate for the chat window
since this is where  you will interact with customers.

If you have added customer information columns that
are essential to your work to the queue, you may
want to have a larger queue area at the expense of

the chat window.

This can be changed from the Layout tab: Click
Large queue panel to change the default.

5.4 Change the queue and the video area

The comprehensive data that Live Guide collects on all customers is available from

the Customer information tab when a chat isin active. Some of this information is
also available in the queue but if other fields would be more useful to you, you can

set up your queue list differently:

1 Select fields from the  Available fields list using the Add /Remove buttons
between the two | ists.
1 Sortthefilesinthe  Selected fields list using the Move up /down buttons to the

right of the list.

Click Save to make your changes permanent; you can always switch between Calls
and Settings to review the effect of your changes.

12



The video area is the area above the chat area. When
neither you nor the customer is using video, the area
shows your picture or a standard picture.

Next to the video or the picture four information fields

are available.
If you would like different information fields in th e
video area, select from the Available fields list.

Note that the limited space available means that you
can select a maximum of four fields.

5.5 Change font size and text color

Use the Fonts tab to make the chat window and the queue panel match your reading
needs.

For the chat window you can increase the font size and choose a different color for
each type of text that can appear in the chat window. This can make it easier to

distinguish between the texts a customer types and your own texts. If you use

forms ° to collect customer information, setting different colors for your questions and

the customerds answers wild.l make it easier to disti
window.

For the queue you can choose different colors for different states . This can make it

easier to distinguish, for example, waiting customers and available operators.

5.6 Ban customer

When you are working in the Operator Console  online environment, you might
occasionally ban a customer who behaves inappropriately. As mentioned in section
3.2 you can do this from the chat area while online with the customer.

You can use the Banned Customers tab to see a complete list of customers who
canno t currently contact any Operator Console operators. If the operator who
imposed the ban added comments, the list will also list the reason for the ban.

To remove a ban:

1 Select a row in the banned customers list and click the Remove button.
You can also ban a customer from the Banned Customers tab.

To ban a customer:

1. Type the computer name or the IP address that you want to ban.

Any bans you set here are effective from subsequent chat s; a ban that you set
from the Options button in the chat area is effective instantly.

2. Type areason why you want to ban the customer and click the Save button.

The new ban is added to the list of banned customers.

® This feature is not available in Netop Live Guide Basic edition .
13



